
Physik und Musik
Fouriersynthese und -analyse

Jean Baptiste Joseph Fourier (1768 - 1830):

Jede beliebige periodische Funktion läßt sich
in eindeutiger Weise aus harmonischen Funktionen
(Sinus- und Kosinusfunktionen) zusammensetzen:
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Die beiden Fourierkoeffizienten an und bn können analytisch be-
rechnet werden können (Dies dient nur Ihrer Information!
Sie müssen die Ausdrücke (noch) nicht verstehen ! )
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Wiederholung: Fouriersynthese
Rufen Sie im Ordner Akustik12\sounds\fourier_ohm\programs
die folgenden beiden DOS Programme auf:

fourier1.exe: Sukzessiver Aufbau der Summenform

 Wählen Sie die Schwingungform
Sägezahn (1), Rechteck (2), Dreieck (3)

 Starten Sie mit der sinusförmigen Grundschwingung [Pos1].
 Durch die Richtungstaste [ ↑ ] können Sie nun

sukzessive je eine Oberschwingung hinzufügen.
 Achten Sie dabei auf Vorzeichen, Amplitude und

Ordnung der hinzukommenden Oberschwingung.

fourier2.exe Summenform, Harmonische, Fourierspektrum

 Zusätzlich zur Summenform sind hier
 die Wellenformen der einzelnen Harmonischen
 das (diskrete) Frequenzspektrum

(Amplitudenwert über Frequenzwert) und
 der mathematische Funktionsausdruck

abgebildet. Mit den Richtungstasten können Sie die Amplituden-
werte [↑,↓] frei wählbarer Oberschwingungen [←, →] verändern.

Sollten Sie nach den folgenden akustischen Arbeitsaufträgen noch Zeit haben, können Sie
sich auf recht einfache und anschauliche Weise (Java-Applet) Ihre eigenen Schwingungs-
formen zusammenbauen (Rufen Sie in Ihrem Webbrowser die HTML-Seite fourier.htm auf
bzw. benützen Sie zu Hause den Link: http://www.physiktreff.de/material/fourier/fourier.htm).

http://www.physiktreff.de/material/fourier/fourier.htm


Fouriersyntese und -analyse
mit CoolEdit 2000

 Starten Sie CoolEdit2000
(Die installierte Trial Version gestattet nur eingeschränkte Funktionalität.
Wählen Sie beim Start die Funktionsgruppen (1) Save und (5) Amplify aus.)

 Erzeugen Sie eine neue Wellenform (Sample Rate 44100 Hz, 16 bit, Mono).

a) Fouriersynthese einer Rechteckschwingung

Generieren ( Generate → Tones ) Sie eine Klangabfolge rechtecksynt.mp3.

 Erzeugen Sie einen Sinuston der Dauer t = 2 s und
der Grundfrequenz (Base Frequency 0) f0 = 440 Hz (siehe Abb. unten).

 Im Gegensatz zur Abb. darf für einen reinen Sinuston nur der Schieberegler
für die erste Frequenzkomponente (Frequenzfaktor 1) auf 100% stehen.

 Spielen Sie den erzeugten Sinuston ab und setzen Sie den Cursor ans Ende
des eben erzeugten Wellenzuges (Go to End, siehe Abb. bzw. [Shift + Ende] )

 Fügen Sie nun sukzessive je eine Oberschwingung hinzu,
indem Sie

 den Frequenzfaktor des Partialtons geeignet wählen und
 den zugehörigen Schieberegler

auf das gewünschte Amplitudenverhältnis schieben

 Fügen Sie den neuen Wellenzug an den bereits bestehenden an (Go to End!!!).
 Speichern Sie den gesamten Wellenzug (rechtecksynt.mp3) in den Ordner Akustik12

Achtung: Im Gegensatz zur Abb. besteht Ihre Aufgabe in der Synthese einer Rechteck
schwingung! Kontrollieren Sie die Wellenform jeweils mit der Zoomfunktion.

Go to End



Die durch Überlagerung entstandenen Wellenzüge
weisen eine im Vergleich zur reinen Sinusschwingung reduzierte Amplitude aus.
 Wodurch kommt die reduzierte Amplitude der Summenform zustande ?

Normieren Sie die Amplituden mit folgendem Verfahren

 Wählen Sie den jeweiligen Zeitbereich
durch Eingabe von Start und Endzeit im Time Display rechts unten.

 Zoomen Sie in den so markierten Bereich (Zoom to Selection)
 Mit der rechten Maustaste stellen Sie die Amplitudenskala auf "Normalized Values"
 Mit gedrückter Maustaste können Sie den sichtbaren Amplitudenbereich vergrößern.
 Berechnen Sie den benötigten Verstärkungsfaktor und

wenden Sie ihn auf den markierten Bereich an (Transform → Amplitude → Amplify ).

Ton / Tonhöhe / Klang / Klangfarbe

 Fügen Sie an das Ende (Go to End!) Ihres Wellenzuges
die durch CoolEdit bereitgestellte Standard Rechteckfunktion (2s Dauer) ein.
(Generate → Tones, eine Frequenzkomponente, Flavor Square)

 Begutachten (Zoom to Selection bzw. Zoom in to Center) Sie
die Veränderungen der Wellenformen in den Übergangsbereiche (2 s, 4 s, 6 s, 8s)

 Spielen Sie den gesamten Wellenzug ab. Was ändert sich ? Was bleibt gleich ?
 Erklären Sie die physikalischen Begriffe Ton und Tonhöhe, Klang und Klangfarbe !

b) Fourieranalyse einer Rechteckschwingung

CoolEdit kann aus Klängen, d.h. aus periodischen Schallwellenformen, welche sich durch die
Überlagerung (Superposition) des Grundtones mit seinen Ober- oder Partialtönen ergibt, die
Amplitudenwerte dieser harmonischen Schwingungsanteile herausrechnen.

 Testen Sie diese Funktionalität mit Ihrem eigenen Wellenzug rechtecksynt.mp3
(schließlich haben Sie ihn selbst erzeugt und wissen, was in ihm steckt!)

 Setzen Sie den Cursor an den Anfang Ihres Wellenzuges ( [Shift + Pos1] ).
 Wählen Sie in der Taskleiste Analyse →→→→ Frequency Analysis (bzw. [Alt + Z])

Das Beispiel zeigt Ihnen, wie man das Analysefenster benutzt:
"FFT-Size" sollte auf dem größtmöglichen Wert (65536) stehen,
"FFT Window Type" auf Triangular, Range auf "60dB" und "Linear View" sollte abgeschaltet sein.



Welchen Zusammenhang stellt das Analysefenster dar,
d.h. Welche physikalischen Größen sind aufgetragen ?
 Fahren Sie Ihren Wellenzug bei geöffnetem

Analysefenster mit der Fast Forward Taste auf der
gesamten Zeitdauer (Cursor im Wellenform-Fenster)
durch und beobachten Sie dabei das
Frequenzspektrum (im Analysefenster)

Bemerkung:
Im Ordner Akustik12\sounds\fourier_ohm\test finden Sie mit der Audiodatei rechteck_sinus.wav
ein Abbild des Demonstrationsversuches der letzten Unterrichtsstunde. Spielen Sie es auf den exter-
nen Lautsprechern ab (Bei Wiedergabe über Kopfhörer müssen Sie die Audiodatei zuerst in Mono-
Widergabe konvertieren (Convert Sample Type) )!

 Ein Rechtecksignal mit der Grundfrequenz f1 = 200Hz (auf dem linken Stereokanal) wird
sukzessive mit reinen Sinustönen der Frequenzen f = 200Hz, 600Hz, 1000Hz, 1400Hz, 1800Hz
(auf dem rechten Stereokanal) überlagert.

 Um sich besser auf die akustischen Schwebungen einstellen bzw. konzentrieren zu können,
wurde die Frequenz der Sinustöne kontinuierlich im Bereich f ±±±± 10 Hz variiert.

 Wenn Sie auch diesen Wellenzug bei geöffnetem Analysefenster mit der Fast-Forward-Taste
(oder durch gezieltes Plazieren des Cursors) durchfahren, können Sie - analog wie Ihr Ohr - die
Überlagerung des Sinustones mit den einzelnen Obertönen des Rechtecksignals beobachten.

Das Ohr ist also ein harmonischer Analysator (Frequenz- oder Fourieranalysator):
 Es kann Tonhöhen (Frequenz der Grundschwingung) und Klangfarben (Frequenzspektrum) un-

terscheiden und sogar - wie dieses Experiment zeigt - die einzelnen Ober- bzw. Partialtöne aus
einem Klang- bzw. Frequenzspektrum herausfiltern bzw. heraushören.

 Das Auge besitzt diese Fähigkeit der spektralen (d.h. Frequenz-) Auflösung nicht !!!

c) Klangfarbe der fundamentalen Schwingungsformen

 Erzeugen Sie einen neuen Wellenzug mit einer Abfolge der
fundamentalen Schwingungsformen Sinus, Dreieck, Rechteck, Sägezahn (je 2 sec).
CoolEdit stellt diese unter dem Auswahlfeld Flavour zur Verfügung.
Beachten Sie dabei, daß nur eine Harmonische (d.h. der Grundton) gewählt ist!

 Spielen Sie Ihren Wellenzug mit verschiedenen Geschwindigkeiten ab.
Wählen Sie hierzu in der Menüleiste Edit > Adjust Sample Rate.
Was bleibt gleich, was ändert sich ?

Bem.: Dies läßt sich mit dem Abspielen einer Schallplatte mit unterschiedlichen Geschwindigkeiten
vergleichen. Die Wellenform, welche Sie eben kreirt haben, entspricht der Furche, in der die Tonnadel läuft !!!

 Welche physikalische Größe bestimmt die Klanghöhe, welche die Klangfarbe?
 Versuchen Sie, die unterschiedlichen Klangfarben physikalisch zu erklären.

 Versuchen Sie, ein "Gehör" für diese unterschiedlichen Klangfarben zu entwickeln in-
dem Sie diese - wenn möglich - der Klangfarbe musikalischer Instrumente zuordnen.

d) Ohmsches Gesetz der Akustik Georg Simon Ohm (1787 - 1854)

Die Audiodatei Ohm.mp3 im Ordner Akustik12>Ohm besteht aus fünf Wellenformen, wel-
che sich nur durch die Phasenlage der einzelnen Partialtöne zueinander unterscheiden.

 Schauen Sie sich die Wellenform der einzelnen Wellenzüge an (Zoom to Selection).
 Frequenz- und (relative) Amplitudenwerte sind gleich (Überprüfen Sie dies, indem Sie

den gesamten Wellenzug bei geöffnetem Analysefenster durchfahren).
 Spielen Sie Audiodatei ab. Welchen Einfluß hat die Phase auf Klanghöhe und -farbe?

Unser Ohr erkennt also Veränderungen von Frequenz (Klanghöhe und Klangfarbe) und/oder Amplitude (Lautstär-
ke), während die Phasen keine Rolle spielen. Diese Erkenntnis geht zurück auf den Physiker Ohm (1787-1854)
und ist unter dem Namen Ohmsches Gesetz der Akustik bekannt. Die Reduzierung auf ein zweidimensionales
Schaubild (Amplituden- über Frequenzwerten) zur Beschreibung der Klangfarbe ist also gerechtfertigt



Physik und Musik
Klangfarbe musikalischer Instrumente

Im folgenden sollen Sie die Klangspektren verschiedener musikalischer Instrumente
 auf charakteristische Merkmale untersuchen und
 mit den physikalischen Bedingungen der Klangerzeugung verknüpfen.

Um ein Gespür für die Wellenform und dem ihr zugrunde liegendem Frequenzspektrum zu entwik-
keln,
betrachten Sie bitte für jede Audiodatei

 Wellenform
(View -> Waveform View) und

 zugehöriges Frequenzspektrum
(Analyse -> Frequency Analysis)

jeweils für mehrere Zeitbereiche
und Zeitfenster (Zoom and Scan).

Bei der Beurteilung und dem
Vergleich des Obertonspektrums
unterschiedlicher Instrumente kann
Ihnen die

Spektralansicht
(View -> Spectral View)
hilfreich sein.

a) Grundton / Partialtöne / Klangfarbe "hart" oder "weich"

Öffnen Sie im Ordner \akustik12\sounds\klang\
die beiden Audiodateien querfloete_medium.aif und trompete_medium.aif

 Bestimmen sie für den ersten "musikalischen Ton"
(physikalisch ist dies ein Klang !!! ) beider Melodien
die Tonhöhe d.h. die Frequenz des Grundtones,
durch Messung der Periodendauer.

Um die Genauigkeit Ihrer Messung zu erhöhen, sollten Sie über mindestens 10 Perioden mitteln.
Die Zeitdauer eines markierten Bereichs kann man im Zeitfenster (Sel - Length) ablesen (s.Abb.).

 Vergleichen Sie beide Wellenformen. Wie unterscheiden sich diese ?



 Bestimmen Sie die Frequenzwerte der ersten sieben Obertöne mit Hilfe der Fourieranalyse
(Analyse > Frequency Analysis, FFT-Size 8192, Triangular, Linear View, 130 dB), indem Sie
den Cursor auf die Amplitudenmaxima plazieren und tragen Sie die Werte in die Tabelle ein.

 In welchem Verhältnis stehen die Obertöne zum Grundton ?

Trompete f [Hz]

f / f0 1

Querflöte f [Hz]

f / f0 1

 Wie viele Obertöne können Sie identifizieren ?
 Mit welchem Charakteristikum des Klang- bzw. Frequenzspektrums

sind die Klangeindrücke "hart" (Trompete) bzw. "weich" (Querflöte) verknüpft ?

Hausaufgabe:
Bei Blasinstrumenten kann man durch sogenanntes "Überblasen" von einem Klangregister in das
nächste gelangen. Dies entspricht der Anregung der nächsthöheren Harmonischen der Rohrlänge.

Durch das Öffnen von Grifflöchern (Holzblasinstrumente) bzw. das Betätigen von Ventilen
(Blechblasinstrumente) kann man die Länge der schwingenden Luftsäule verkürzen bzw. verlängern.

 In welchem Klangregister des jeweiligen Instrumentes liegen die oben bestimmten Tonhöhen,
wenn die Rohrlänge der Querflöte L = 67 cm und die der Trompete L = 146 cm beträgt ?

 Berechnen Sie für die beiden Tonhöhen die Länge der schwingenden Luftsäule. Sind Grifflöcher
geschlossen bzw. Ventile betätigt worden, um die jeweiligen Tonhöhen zu erzeugen ?

 Die Tonhöhen, welche ein Blechblasinstrument allein durch Überblasen (d.h. ohne Betätigung
der Ventile) spielen kann, nennt man Naturtonreihe. Berechnen Sie diese für die Trompete !

b) Offene und gedackte Pfeifen / Oboe / Klarinette

Die Audiodateien blockfloete1.wav im Ordner \akustik12\sounds\klang\ vergleicht den Klang der
offenen Blockflöte mit dem Flötenkopf, welcher hierbei mit einer Hand zugedeckt ("gedackt") wur-
de.

 Erklären Sie die Klangunterschiede!
Benutzen Sie hierzu am besten die Spektralansicht (View →→→→ Spectral View)

 Vergleichen Sie die Darstellungen Wellenform, Frequenzspektrum und Spektralansicht:
 Welche physikalische Größe (Zeit, Frequenz, Amplitude) wird auf welche Weise darge-

stellt ?
 Welche Darstellung eignet sich für welche Untersuchungen ?

Öffnen Sie die Audiodateien oboe.wav und klarinette.wav.

 Betrachten Sie beide Wellenformen (Zoom) und
bestimmen Sie die Tonhöhe durch Messung der Periodendauer (analog zu Aufgabe a).

 Berechnen Sie die Vielfachen der Grundfrequenzen und tragen Sie diese in die Tabelle ein:

f / f0 1 2 3 4 5 6 7 8

Oboe f [Hz]

Klarinette f [Hz]

 Welche Partialtöne treten auf, welche dominieren, welche sind nicht vorhanden ?
 Welches Klangspektrum entspricht bzw. widerspricht Ihren Erwartungen ?



c) Einschwingvorgang von Lippenpfeifen / Blockflöte

Öffnen Sie die Audiodatei blockfloete.wav.

 Betrachten Sie den zeitlichen Verlauf des Klangspektrums in der Spektralansicht.
 Beschreiben Sie den Anblasvorgang (die ersten 50 ms),

indem Sie Wellenform und Frequenzspektrum (FFT-Size 8192, 80 dB)
während des Anblasens mit denen der stabilisierten Luftschwingung vergleichen.

 Markieren Sie ein Zeitfenster ohne Anblasvorgang und spielen Sie diesen Abschnitt wieder-
holt ab (play looped). Wiederholen Sie dies mit einem Zeitfenster, welches den Anblasvor-
gang beinhaltet. Läßt sich die Blockflöte auch ohne Anblasvorgang wiedererkennen.

d) Abklingen gezupfter bzw. geschlagener Saiten

Öffnen Sie die Audiodatei floete_gitarre.wav.

 Vergleichen Sie den zeitlichen Verlauf des Klangspektrums (Spektralansicht !)
eines Blasinstruments (Blockflöte) mit dem eines gezupften Saiteninstrumentes (Gitarre).

 Erklären Sie die Unterschiede !

Öffnen Sie die Audiodateien klavier_gliss.aif und gitarre_butte.aif und betrachten Sie
den zeitlichen Verlauf der Klangspektren gezupfter (Gitarre) und angeschlagenen Saiten (Kla-
vier).
 Wie lassen sich die zeitlichen Veränderung des Klangbildes erklären ?

e) Obertonmusik

Öffnen Sie die Datei obertonsaenger.mp3.

 Erklären Sie durch schrittweise Frequenzanalyse
(Fast Forward) über den zeitlichen Klangverlauf
bzw. durch Beschreibung der Spektralansicht,
was man unter Obertonmusik versteht.

 Was bleibt gleich, was ändert sich ?
 Bilden Sie sich eine Vorstellung,

wie diese Veränderung zustande kommt!

f) Sprachanalyse und -synthese
Vokalanalyse:

 Nehmen Sie verschiedene Vokale mit Ihrem Mikrofon 
auf und analysieren Sie das Frequenzspektrum.

 Versuchen Sie die Vokale dem Formantdiagramm
(Abbildung rechts) zuzuordnen.

Vokalsynthese

 Verwenden Sie Ihr eigenes Vokalspektrum
oder öffnen Sie die Audiodatei \Akustik12\sounds\sprache\vokale_male.wav

 Skizzieren Sie das Frequenzspektrum auf ein Blatt Papier (logarithmischer Maßstab).
 Die Datei grund.mp3 enthält ein ausgeglichenes Klangspektrum,

d.h. im Bereich bis 6000 Hz sind alle Frequenzen mit annähernd gleicher Amplitude vertreten.
 Mit den Filterfunktionen von CoolEdit (Transform -> Filters -> FFT-Filter)

können Sie in diese Datei Formanten "hineinschneiden".
 Versuchen Sie, auf diese Weise Ihre Vokale zu synthetisieren.



Frequenzbestimmung über Periodendauer:

Querflöte: T = 39 ms / 20 = 1,95 ms ⇒ f = 1/T = 1/(1,95 ms) = 513 Hz
Trompete: T = 50 ms / 20 = 2,50 ms ⇒ f = 1/T = 1/(2,50 ms) = 400 Hz

Querflöte (Wenige Obertöne (nur 6 erkennbar), Sinusförmige Wellenform, Weicher Klang, streng harmonisch)

f [Hz] 508 1014 1521 2028 2535 3042 3550

f / f1 1,00 2,00 3,00 3,99 4,99 5,99 6,99

f [Hz] 508 1016 1524 2032 2540 3048 3556

Berechnung der schwingenden Luftsäule L*:
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Trompete (Viele Obertöne (26 sichtbar), nicht sinusförmige WF, Harter Klang, mehr und mehr "anharmonisch")

f [Hz] 400 789 1185 1570 1955 2371 2756 3156 3556 3941 4342 4727 5127 5512 5912

f / f1 1,00 1,97 2,96 3,92 4,88 5,92 6,88 7,88 8,88 9,85 10,85 11,81 12,8 13,8 14,8

f [Hz] 400 801 1201 1601 2002 2402 2802 3202 3603 4003 4403 4804 5204 5604 6005

Berechnung der schwingenden Luftsäule L*:
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Berechnung der Naturtonreihe:
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f1 = 116,5 Hz (B); f2 = 233 Hz (b); f3 = 349,5 Hz (f); f4 = 466 Hz (b');

"Hart und Weich"
 Trompete: hoher Anteil von Obertönen (harter Klang)
 Querflöte: geringer Anteil von Obertönen (weicher Klang)

Oboe, Saxophon, Klarinette:

 Grundton: f = 259 Hz
 Oboe: Dominierend ist 1297 Hz

f / f0 1 2 3 4 5 6 7 8

Oboe f [Hz] 259 518 777 1036 1295 1554 1813 2072

Klarinette f [Hz] 259 518 777 1036 1295 1554 1813 2072

 Klarinette:
 Zweite und vierte Harmonische sind unterdrückt,
 sechste und achte Harmonische jedoch nicht!

 Randbedingungen: ein Ende offen, eines geschlossen



Physik und Musik
Akustische Täuschungen

Unser akustischer Wahrnehmungsapparat (Ohr und Gehirn) hört die Außenwelt nicht einfach so,
"wie sie ist": Schon im Innenohr laufen Prozesse ab, die einige der eingehenden Informationen
verstärken und andere wegfiltern. Im Gehirn kommt es zu weiteren Deutungen des Gehörten. Dies
geht so weit, dass man unter geeigneten Bedingungen Töne wahrnimmt, die nachweisbar nicht
von außen kommen. Solche Phänomene könnte man "akustische Täuschungen" nennen. Die Ver-
suche dieses Teilthemas entstammen zum großen Teil dem Artikel "Hörexperimente: Nichtlineare
Dynamik auf materieller und mentaler Ebene" von Manfred Euler (in: Biologie in unserer Zeit, 26.
Jg. 1995, Heft 5).

1. Schwebungen / Ortstheorie / Begrenzte Trennschärfe

Empfängt das Ohr zwei Töne, deren Frequenzen nur wenig voneinander verschieden sind, so
nimmt man nur einen Ton wahr, dessen Lautstärke periodisch an- und abschwillt. Dieses Phäno-
men heißt Schwebung und ist in der begrenzten Trennschärfe des Ohres begründet.

Musiker verwenden Schwebungen, um Instrumente zu stimmen. Man schlägt die "a"-Saite an und
gleichzeitig eine Stimmgabel. Nun ändert man die Saitenspannung so lange, bis keine Schwebung
mehr zu hören ist. Beide Schallquellen schwingen nun mit der gleichen Frequenz.

 Erzeugen Sie eine Stereo-Datei (New -> Stereo Datei (44100 Hz Sample Rate, 16bit, Ste-
reo)) oder verwenden Sie die Datei akustik12\sounds\taeuschungen\sinus400-
480_stereo.mp3.

 Auf den linken Kanal geben Sie einen
Sinuston fester Frequenz (Kammerton a mit f = 440 Hz)
Select left Channel [Ctrl-L] > Generate Tones > Sinus 440 Hz, 20 sec

 Auf den rechten Kanal lassen Sie einen
Sinuston den Frequenzbereich von f = 400 Hz bis f = 480 Hz durchlaufen
Select right Channel [Ctrl-R] > Generate Tones > Sinus 400 Hz (initial settings)

480 Hz (final settings), 20 sec

 Spielen Sie die Stereodatei sowohl über die externen Lautsprechern als auch über Ihre
Kopfhörer ab. Erklären Sie, warum Sie im zweiten Fall keine Schwebung wahrnehmen kön-
nen.

 Konvertieren Sie die Stereodatei in Mono (Edit > Convert Sample Type > Mono)
und spielen Sie diese Datei über Ihren Kopfhörer ab. Betrachten Sie die Wellenform.

 Um die individuelle Trennschärfe Ihres Ohres zu bestimmen,
markieren Sie kleinere Zeitbereiche und spielen diese mit der Loopfunktion wiederholt ab.
Ab welchem Frequenzunterschied können Sie getrennte Töne wahrnehmen?



2. Kombinationstöne / Grenzen des Superpositionsprinzips

Das Prinzip der ungestörten Überlagerung (Superpositionsprinzip) ist unabdingbare Voraus-
setzung für Fouriersynthese und -analyse. Die Überlagerung der Wanderwellen im Innenohr ist je-
doch z.T. nicht-linear, d.h. zwei Wellen mit verschiedenen Frequenzen f1 und f2 können so mitein-
ander wechselwirken, daß neue Frequenzen, sog. Kombinationsfrequenzen entstehen:

Nn,mmitfnfmfkomb ∈±= 21

Erzeugen Sie - analog zur Datei sinus400-480_stereo.mp3 der vorangegangenen Übung - eine
Stereodatei, wobei der auf dem rechten Kanal überstrichene Frequenzbereich von 200 Hz bis
800 Hz reicht. Sie können auch fertige Datei aku-
stik12\sounds\taeuschungen\kombination.mp3 öffnen.

Achten Sie auf folgendes akustisches Empfinden:

 Im Bereich von f2 = 250Hz - 350Hz
d.h. zwischen t = 2s und t = 5s
können Sie im Hintergrund einen
rasch ansteigenden Brummton
der Frequenz f = 2 f2 −−−− f1 wahrnehmen.

 In unmittelbarer Nähe von f2 ≈ 400 Hz = f1

(t = 6,7s) werden Sie Schwebungen hören.

 Im Bereich von f2 = 450Hz - 600Hz
d.h. zwischen t = 8s und t = 13s
können Sie im Hintergrund sowohl einen
ansteigenden ( f = 2 f2 −−−− f1 ) als auch einen
absteigenden ( f = 2 f1 −−−− f2 ) Ton
wahrnehmen.

Diese Kombinationstöne können erst bei relativ
großer Lautstärke der beiden erzeugenden Töne
gehört werden.

Bemerkung:

Bei Übersteuerung eines elektroakustischen Verstärkers sind diese Töne tatsächlich
d.h. auch physikalisch vorhanden und durch das nicht-lineare Verhalten des Verstärkers be-
dingt.



3. Residuumstöne / Fehlender Grundton

Die überragende Bedeutung der Obertöne

 nicht nur für die Empfindung einer Klangfarbe (über ihren relativen Amplitudenbeitrag),
 sondern auch für die Tonhöhenbestimmung  (über ihren konstanten Frequenzunterschied)

zeigt sich besonders deutlich bei dem Phänomen der Residuumstöne (fehlender Grundton):

Sind von einem Klang nur Obertöne vorhanden, so "rekonstruiert" unser Gehirn die vermutete
fehlende Grundfrequenz: Ist beispielsweise von einem Klang mit der Grundfrequenz f = 100 Hz
nur die 20, 21. und 22. Oberschwingung vorhanden (also die Frequenzen 2000 Hz, 2100 Hz, 2200
Hz), so hören wir nicht nur ein hochfrequentes Tongemisch, sondern wir hören deutlich die Grund-
frequenz (als tiefen Brummton) heraus.

 Überzeugen Sie sich hiervon, indem Sie die Datei taeuschungen\residuum.mp3 abspielen.

 Die Datei schneider_wav\physio\fehlfund.wav demonstriert diesen Effekt durch den Ver-
gleich (Überprüfen Sie die tatsächliche d.h. physikal. Existenz der Obertöne durch Fre-
quenzanalyse !!)

 eines reinen Sinustones mit f = 160 Hz
 eines Rechteckklanges dergleichen Tonhöhe(fk = (2k-1)*160 Hz; k = 1, 2, 3,...)
 eines Rechteckklanges mit "fehlendem Grundton" (fk = (2k-1)*160 Hz; k =     2, 3,...)

d.h. die niedrigste Frequenz ist hier f3 = 480 Hz
und damit zwei Oktaven höher als der Grundton.

 Noch deutlicher hört man diesen Effekt bei der Audiodatei taeuschungen\resid300.mp3.
Diese erzeugt gleitende Obertöne (2,0 kHz, 2,3 kHz, 2,6 kHz, 2,9 kHz aufwärts auf 3 kHz)
und damit auch einen gleitenden Residuumston (von 300 Hz abwärts auf 0 Hz)

Besonders im Kontext einer Melodie werden solche Töne, deren Frequenzen physikalisch nicht
vorhanden sind und erst durch den Wahrnehmungsapparat ergänzt werden, durchaus akzeptiert.

Dies zeigt sich z.B. bei der Wiedergabe tiefer
Frequenzbereiche durch die Lautsprecher von Tran-
sistorradios oder bei akustischen Glückwunsch-
karten:

Die hierin verpackten Piezo-Lautsprecher können
nur Töne mit einer Frequenz über f > 2 kHz mit hör-
barer Lautstärke abgeben, für tiefere Töne sind sie
ungeeignet. Für deren Wiedergabe bzw. Vortäu-
schung macht man sich den eben besprochenen
Effekt der Residuumstöne zu Nutze.

Spielen Sie die Audiodatei residuum_piezo.wav bei
geöffnetem Analysefenster ab (FFT-Size 4096,
Triangular, Linear View, Range 40dB, Ref. -24 dBFS)

 Die ersten vier Töne (Hoch-soll-er-le) haben die gleiche Tonhöhe; die Spektren bestehen
i.W. aus fünf scharfen Linien (siehe Abb.) im Frequenzbereich 2,5 kHz bis 4,6 kHz mit
einem festen gegenseitigen Abstand von 514Hz. Dies entspricht dem zweigestrichenen C.

 Beim nächsten Ton (-ben) ist der Abstand der einzelnen Linien 382 Hz (G1).
 Die nächsten vier gleichen Töne (Hoch-soll-er-le)

werden durch einen gegenseitigen Frequenzabstand von 650 Hz (E") bestimmt.
 Beim nächsten Ton (-ben) ist der Abstand der einzelnen Linien wieder 514 Hz (C").



4. Der Shepard Effekt:
Endlos steigende Tonfolgen

Die bekannte Lithographie "Treppauf, Treppab" von Maurits
Cornelis Escher (nach einer Idee von L.S. und Roger
Penrose) zeigt eine unmögliche Situation: Mönche steigen
in einer unendlichen Abfolge Stufe um Stufe einer Treppe
treppauf bzw. treppab.

Einen ähnlichen unendlichen Zyklus gibt
es auch akustisch: Die Shepard-Tonleiter.
(nach dem Psychologen und Akustiker Roger N. Shepard)

Spielen Sie die Audiodatei shepard.wav ab.

Hier geht es mit der Tonhöhe offensichtlich bergauf. Das verblüffende dabei ist, daß man diese
Tonspirale beliebig lange laufen lassen kann, ohne daß der Ton schließlich an der Hörgrenze an-
kommt.

In seinem Buch "Goedel, Escher, Bach, ein endlos geflochtenes Band" gibt der Autor Douglas R.
Hof-stadter ein Rezept zur Konstruktion einer Shepard-Tonfolge an. Es ist in der folgenden Abbil-
dung wiedergegeben:

 Das Notenbild zeigt vier gleichzeitig gespielte Halbtonfolgen, die sich jeweils
um eine Oktave voneinander unterscheiden d.h. für die Frequenzen gilt: f1, 2f1, 4f1,
8f1..

 Alle Folgen erstrecken sich über eine Oktave
d.h. Die Grundfrequenz f1 hat sich innerhalb der Tonfolge verdoppelt.

Das besondere an der Tonfolge sind die Lautstärken innerhalb der Einzelstimmen,
die im Notenbild durch die Fläche der Notenköpfe symbolisiert sind:

 Die Lautstärke der höchsten Stimme nimmt ab:
Sie beginnt bei halbem Volumen und erreicht am Ende der Oktave den Wert Null.

 Die Lautstärke der zweithöchsten Stimme fällt ebenfalls:
Sie beginnt bei vollem Volumen und erreicht am Ende der Oktave das halbe Volumen.

 Die Lautstärke der dritthöchsten Stimme nimmt zu:
Sie beginnt bei halbem Volumen und erreicht am Ende der Oktave das volle Volumen.

 Die Lautstärke der tiefsten Stimme steigt ebenfalls:
Sie beginnt bei null und erreicht am Ende der Oktave das halbe Volumen.

Der letzte Klang ist also mit dem ersten identisch und die Tonfolge somit geschlossen.

Mehr Infos zu akustischen Täuschungen im Web:

 http://users.aol.com/gykophys/shep.htm
 http://cips02.physik.uni-bonn.de/~scheller/acoustic-illusions/main.html

http://users.aol.com/gykophys/shep.htm
http://cips02.physik.uni-bonn.de/~scheller/acoustic-illusions/main.html
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